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Apresentação	
Este material foi elaborado com a intenção de ajudar alunos inscritos em cursos do Núcleo de 
Estratégias e Políticas Editoriais (NESPE) que precisem, por qualquer motivo de uma 
introdução ao InDesign.  

Esta apostila não é material constituinte nem obrigatório de curso nenhum, e é distribuído 
gratuita e livremente. 

Para enriquecer o conteúdo, vários links para vídeos do YouTube foram incluídos. Não nos 
responsabilizamos pela continuidade da disponibilidade destes vídeos. Se em algum 
momento for notado que algum deles não está mais disponível, por favor envie-nos um e-
mail para contato@nespe.com.br informando qual URL não está funcionando. 

 

Quem	somos	
O Núcleo de Estratégias e Políticas Editoriais (NESPE), é um centro de pesquisas sobre o 
mercado editorial, a produção, a circulação, a história e o comércio de publicações impressas 
e digitais, bem como o desenvolvimento de conteúdos editoriais em suas diversas 
modalidades. 

Nosso objetivo é produzir, promover e compartilhar informações que possam contribuir para 
o aprimoramento de pesquisadores e profissionais de mercado, consequentemente, 
colaborando para a consolidação de um ambiente editorial maduro e saudável. 
Saiba mais em www.nespe.com.br 
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Introdução	ao	InDesign	
O	que	é	InDesign	e	para	que	serve	
O InDesign é um programa gráfico que faz parte do pacote gráfico da Adobe. Ele é muito 
usado para criar trabalhos como pôsteres, flyers, brochuras, revistas, jornais e livros. Ele 
também pode ser usado para fazer e-books e e-magazines.  

 
Se o PhotoShop é normalmente utilizado para manipular imagens bitmap e o Illustrator para 
criação de ilustrações vetoriais, o InDesign foi criado para agilizar a produção de produtos 
caracterizados pela grade quantidade de texto, muitas vezes se estendendo por várias páginas, 
em que há também a presença de ilustrações e imagens, geralmente produzidas em outros 
programas e inseridas no InDesign posteriormente. 

 

Interface	básica	
Ao abrir um arquivo no InDesign, pode-se localizar: 

(1) A área de trabalho, representada por uma ou mais páginas do trabalho 
(2) A barra de ferramentas principal 
(3) O menu principal, similar a de tantos outros programas para Windows ou Mac. 
(4) A barra de controle 
(5) Uma seleção de painéis.  

 
 
A visualização destas barras e painéis pode variar. Isso pode ser controlado a partir do menu 
Window: 
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 Cada uma das opções deste menu representa um painel ou barra. Para mudar uma barra ou 
painel de posicionamento, basta selecionar e arrastar. 
O InDesign vem com alguns modos de organização destas barras e painéis, pensando na 
otimização da elaboração de diversos produtos finais (basic, advanced, book, typography, 
PDF interativo, etc). É possível selecionar uma destas visualizações predefinidas ou salvar 
suas favoritas em Window> Workspace. Para saber mais sobre espaços de trabalho, assista: 
https://www.youtube.com/watch?v=s5kNz-cjKzA&index=4&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka 
 

 

Barra	de	ferramentas	
A barra de ferramentas é a mais usada no InDesign. É a partir dela que podemos criar objetos 
e textos. Também é a partir dela que selecionamos objetos e textos a fim de manipulá-los 
utilizando recursos presentes em outras barras ou painéis. Veremos várias de suas 
ferramentas ao longo deste documento.  
Abaixo, uma imagem da barra de ferramentas com os nomes de cada uma delas: 
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(1) Selection tool - Ferramenta de seleção 
(2) Direct selection tool – ferramenta de seleção direta 
(3) Page tool – Ferramenta página 
(4) Gap tool – Ferramenta intervalo 
(5) Content collector tool – Ferramenta de coleção de conteúdo 
(6) Content placer tool – Ferramenta de disposição de conteúdo 
(7) Type tool – Ferramenta de texto 
(8) Line tool – Ferramenta linha 
(9) Pen tool – Ferramenta caneta 
(10) Pencil tool – Ferramenta lápis 
(11) Rectangle frame tool – Ferramenta moldura retângulo 
(12) Rectangle tool – Ferramenta retângulo 
(13) Scissors tool – Ferramenta tesoura 
(14) Free transform tool – Ferramenta transformação livre 
(15) Gradient tool – Ferramenta gradiente 
(16) Gradient feather tool – Ferramenta gradiente transparente 
(17) Note tool – Ferramenta de notas 
(18) Eyedropper tool – Ferramenta conta-gotas 
(19) Hand tool – Ferramenta mão 
(20) Zoom tool – Ferramenta lupa 
(21) Área de seleção de cores de contorno e preenchimento 
(22) Muda o modo de visualização da área de trabalho 

 
OBS: As ferramentas que apresenta um pequeno triângulo ao lado, 
quando clicadas prolongadamente, oferecem outras opções, em geral 
semelhantes àquela inicial. Por exemplo, ao clicarmos na Rectangle tool 
(ferramenta utilizada para desenhar retângulos), teremos outras opções 
de forma, como Ellipsis tool (ferramenta elipse). Veremos algumas delas 
neste manual. 
 

 

 

 
 

Barra	de	controle	
A cada ferramenta escolhida, em combinação ou não com texto selecionado, a barra de 
controle muda, apresentando opções diferentes para cada situação. 

 
Aparência da barra de controle quando a ferramenta Type é selecionada: 
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Aparência da barra de controle quando a Selection tool é selecionada: 

 
 

Painéis	
Painéis funcionam como janelas de opções, estendo o número de funcionalidades do 
programa de modo dinâmico. Ao longo deste documento serão apresentados diversos painéis. 
 

Documentos	no	InDesign		
Para abrir um documento, basta ir a File> Open 

Para iniciar um novo documento em branco, clique em File>New>Document, ou digite 
Ctrl+N.  

A figura abaixo lustra a janela e explica algumas das opções que você deverá completar antes 
para iniciar seu trabalho: 

 

  

1. Configurações salvas 
2. Intenção: Impresso, web... 
3. Número de páginas (pode ser mudado 

depois) 
4. Número da página inicial 
5. Selecione “facing pages” se você quiser 

que o documento seja frente e verso 
6. Tamanho da página (Oficio, A4, etc). Se 

quiser um tamanho customizado, 
preencher os dois campos seguintes 

7. Largura da página 
8. Altura da página 
9. Orientação da página: retrato ou 

paisagem 
10. Número de colunas por página 
11. Largura entre as colunas 
12. Margens: top (topo), bottom (pé da 

página), inside (interna) e outside 
(externa) 

13. Bleed (área de sangria) e slug (área de 
segurança 

 

Todas essas informações podem ser alteradas posteriormente em File > document setup, a 
exceção das margens e colunas, que pode ser encontrado em Layout >Margins and Columns. 
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Em linhas gerais, um documento de InDesign funciona bastante como qualquer outro 
arquivo, com comandos como Save, Save As..., Save A Copy... e Revert. 

O que muda é que, quando inserimos um elemento externo, como uma imagem, por exemplo, 
temos a opção de incluí-lo diretamente no arquivo ou, ainda, criar um link com o arquivo 
original. Neste caso, se alterarmos o local ou o nome do arquivo utilizado, o documento 
InDesign perderá a referência e não conseguirá mostrar satisfatoriamente a imagem.  

 

Páginas	
Páginas são a base do documento InDesign. São elas que delimitam a área a do documento e 
o espaço que temos a disposição para o layout. 

Painel	Pages	
No Painel Pages é possível ver os thumbnails das páginas presentes no seu documento. 
  

  

(1) Mais opções, como duplicar páginas e 
opções de paginação. 

(2) Área de página mestre (mais sobre isso nas 
próximas seções)  

(3) Thumbnails das páginas pertinentes ao 
layout. O número da página é mostrado 
logo abaixo. Se configurado “facing 
pages”, o verso de uma folha aparece ao 
lado da frente da folha seguinte. Assim 
pode-se visualizar as páginas como em um 
livro ou revista. 

(4) Quando uma ou mais páginas estão 
selecionadas em (3), é possível mudar o 
tamanho destas páginas sem alterar as 
outras do documento. 

(5) Insere nova página 
(6) Deletar página selecionada 

 
 

Para saber mais, assista: 
https://www.youtube.com/watch?v=zPfJrfJaRfU&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=5 
 

 
1.1. Páginas mestre 

Imagine que você vai fazer um livro. Todas as páginas pares deste livro devem ter o título do 
livro e toda página par deve ter o nome do capítulo. Além disso, todas as páginas de texto 
devem ser numeradas.  
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A página mestre serve como recurso para que não tenhamos que inserir essas informações em 
cada uma das páginas manualmente. Ela funciona como um fundo que pode ser aplicado 
rapidamente a uma ou mais páginas.  
Um documento de InDesign pode ter várias páginas mestre. Quando uma página mestre é 
aplicada em uma página, tudo o que está primeira aparece na segunda. Se uma página mestre 
é alterada (suponhamos que o título de um capítulo tenha mudado), todas as páginas em que 
ela está aplicada também mudarão. 

 

 

Selecionando o menu opções do painel Pages, é 
possível selecionar: 

(1) “New Master...”. Esta opção abre a janela de 
configuração de nova página mestre, vista na 
tabela abaixo. 

(2) Abre a janela onde se seleciona quais 
páginas aplicar determinada página mestre 

 

 

 

(1) Prefixo: é a letra ou número que 
aparecerá no thumbnail de cada página 
em que essa página mestre for aplicada. 
Assim, será mais fácil controlar qual 
página mestre está aplicada em cada 
página olhando no painel Pages 

(2) Nome da página mestre 
(3) Se quiser criar uma página mestre 

baseada em uma já existente 
(4) O número de páginas que você quer que 

essa página mestre tenha 
(5) Tamanho da página mestre, só 

necessário se o seu documento tiver 
página de tamanhos diferentes. 

 

Aplicando uma página mestre em uma página: 

 

Selecione o menu opções do painel Pages e 
depois selecione “apply master to pages...”. 
Será aberta a janela “apply master”: 

(1) Selecione a página mestre a ser aplicada.  
(2) Escolha a página ou intervalo de páginas 

onde aquela página mestre deve ser 
aplicada. 
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Alternativamente, no painel Pages, pode-se arrastar os thumbnails das páginas mestre à 
página em que se quer que ela seja aplicada. 

 

 
 

Para saber mais, assista 
https://www.youtube.com/watch?v=vDxLcIUlppo&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=8 
https://www.youtube.com/watch?v=oL7Hsnaf9tQ&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=9 
https://www.youtube.com/watch?v=a8VJdz8FY3o&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=10 
 

 

Page	tool	–	Ferramenta	página		

A page tool  serve para mudar o tamanho de uma página manualmente. Com a 
ferramenta selecionada, clique na página e depois clique e arraste na linha delimitadora dela. 
 

Navegação	e	controle	
A medida em que seu arquivo vai aumentando em página e em nível de detalhe, alguns 
recursos passam a ser necessários para conseguir controlar seu trabalho.  
 

  

 No painel Pages, um duplo-clique no thumbnail de uma 
determinada página fará com que esta seja visualizada. 

  

  
 Hand tool: desloca a visualização do documento na tela. 

Também é possível acessá-la pressionando a barra de espaço 
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Zoom: aproxima e afasta os objetos, ou aumenta e diminui o 
zoom. Para aumentar use a ferramenta, digite Ctrl junto com o 
sinal de mais (+) ou ainda vá ao menu principal View > Zoom 
In. Para reduzir, use a ferramenta com a tecla Alt apertada, 
digite Ctrl junto com o sinal de menos (-), ou View > Zoom Out 

  

 
 

Margins	e	Columns	
Após a configuração inicial do seu documento, é possível alterar as configurações de 
margens, colunas e entrecolunas em Layout >Margins and Columns. 

 
 

Selecionando “Enable layout adjustment”, o conteúdo já existente na sua página antes da 
alteração será ajustado automaticamente à nova mancha gráfica formada a partir das colunas 
e margens. 
 

 

Linhas	Guia	
Linhas-guia são um recurso interessante para ajudar no alinhamento e organização dos 
elementos na página. Uma linha-guia criada em uma página mestre será replicada em todas as 
páginas em que esta página mestre for aplicada 

Para criar uma linha guia, posicione o ponteiro dentro de uma régua horizontal ou vertical (1) 
e arraste para o local desejado na página (2).  
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Menu	preferências	
Na janela de preferências pode-se configurar inúmeras opções do InDesign, começando pela 
unidade de medida a ser usada para objetos e texto (ex.: milímetros, pixel, pontos, polegadas, 
paicas, etc), desenhar grids, determinar linhas de base, recursos de linguagem e dicionário, 
etc. 
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Texto	
Os pontos mais importantes sobre a inserção e manipulação de texto no InDesign pode ser 
visto nestes vídeos:  

https://www.youtube.com/watch?v=OH7xEZoj3JQ&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=6 

https://www.youtube.com/watch?v=oIpUWb-71Qc&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=7 

 
Estilos de caractere e de parágrafo servem para guardar características de parágrafos que se 
repetem ao longo do texto. Deste modo podemos aplicar um grupo de características de uma 
só vez a um ou mais parágrafos, economizando tempo e evitando erros de esquecimento. 
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Para entender como trabalhar com estilos de parágrafo, assista: 
https://www.youtube.com/watch?v=vRnu8Tf_bsc 

 
 

Desenhando	formas	e	cores	no	InDesign	
Uma introdução ao desenho de formas vetoriais pode ser assistida em 
https://www.youtube.com/watch?v=80dNCVHuyX8&index=13&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka 

Este vídeo também explica onde e como podemos alterar as cores de objetos no InDesign, 
assim como a diferença entre cor de contorno e cor de preenchimento. Para saber mais sobre 
cores, assista também: https://www.youtube.com/watch?v=RB-yS26cQWs 
A ferramenta caneta é uma valiosa ferramenta para desenhar diretamente nas páginas do 
InDesign. Para aprender a usá-la, assista: 
https://www.youtube.com/watch?v=S8b18HsK8sA&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=14 
Se você não domina o painel Pathfinder do Illustrator, o InDesign tem os mesmos recursos. 
Caso você não conheça o painel, vale assistir a seguinte aula: 
https://www.youtube.com/watch?v=14f6-5M9Fo0 

 

Imagens	
Para uma explicação sobre como inserir imagens e como arquivos de imagens se comportam 
no InDesign, assista aos seguintes vídeos: 
https://www.youtube.com/watch?v=yXmcVBFSf5A&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=11 

 
https://www.youtube.com/watch?v=8qOCF94E7t8&list=PLBgSZOd1Ka-
wL7raXISuAjtuc1uqFr8Ka&index=12 
 

Extras	
Table	of	Contents	
O InDesign oferece um recurso automático de criação de sumários e índices que agilizam 
imensamente a produção de publicações extensas. Para entender como funciona, assista: 
https://www.youtube.com/watch?v=UE73p1KmsXg 

 

Contornando	uma	imagem	com	texto	
Assista a este vídeo para conhecer a funcionalidade text wrap: 

https://www.youtube.com/watch?v=rvThsO2DOfI 
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Efeitos	em	objetos	
Assim como o Illustrator, o InDesign oferece alguns efeitos aplicáveis a objetos e texto: 

https://www.youtube.com/watch?v=WV9lugIxLQ0 
 

Paginação	automática	
A numeração automática de página inserida em uma página mestre mostra o número de 
página correto onde a página-mestre for aplicada. Para entender como isso funciona, assista o 
seguinte tutorial: https://www.youtube.com/watch?v=jtbjciCEj-s 
 

Finalizando	arquivos	
Pre-flight	
O recurso de preflight nos ajuda a ter certeza de que todos os links para conteúdo externo do 
InDesign, como imagens e fontes estão vinculadas corretamente ao documento, além de 
checar outros problemas, como imagens em baixa resolução ou imagens que utilizam espaço 
de cor erradas (como uma imagem em RGB em um arquivo para impressão) 
Para ver como funciona, assista: 
https://www.youtube.com/watch?v=5stZao9P30Y&list=PLfY4aYg9e-
lPW4cI9GvRhe6M0JOr0LrfC&index=12 

 

Package	
Quando vamos levar um arquivo a gráfica, ou mesmo para mover todo o seu trabalho para 
outro computador, é essencial ter certeza que todos os arquivos envolvidos no projeto sejam 
selecionados. O InDesign pode fazer isso por você, por meio de um recurso chamado 
package, ou pacote. 
Para ver como este recurso funciona, assista: 
https://www.youtube.com/watch?v=JNJlLlr9UGU 
 

 

Criar	publicação	em	PDF	
Passo a passo sobre como criar arquivos em pdf a partir do InDesign: 

https://www.youtube.com/watch?v=gN-OTpa7YYc 
 

  




